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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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1 Product basics

● Product comparison

● Environmental features

● Accessibility features

● Product views
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Product comparison
Base model Network model

● Speed: Prints up to 16 A4-size pages per minute (ppm) or 17
letter-size ppm monochrome and 4 ppm color

● Tray: 150 sheets of 75 g/m2 (20 lb)

● Output bin: 50 sheets of 75 g/m2 (20 lb)

● Connectivity: Hi-Speed USB 2.0 port

● Two-sided printing (duplexing): Manual duplexing (using the
printer driver)

● Introductory print cartridges: Supplied with product

HP LaserJet Pro 100 color MFP M175 plus:

● Connectivity: 802.11b/g/n wireless networking and built-in
networking to connect to 10Base-T/100Base-TX networks
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Environmental features

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy with sleep mode and low power mode.

HP Instant-on Technology produces the first page faster when the product is coming out sleep
mode or low power mode so that the print job is done sooner.

Manual duplex printing Save paper by using the manual duplex printing setting.

Print multiple pages per
sheet

Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Accessibility features
The product includes several features that aid users with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● All doors and covers can be opened by using one hand.
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Product views

Product front view

1

4

3

2

5

6

7

8

1 Document feeder

2 Scanner

3 Output bin

4 Power button

5 Main-input tray

6 Front cover (provides access to the imaging drum)

7 Print cartridge door (provides access to the print cartridges)

8 Control panel
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Product back view

2

3

4

5

1

1 Security slot

2 Rear jam-access door

3 USB port

4 HP internal network port (network models only)

5 Power receptacle

Serial number and model number location

The label that contains the product and serial numbers is on the inside of the front cover.
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Control panel layout

1 3

11

10

8

9

7
6

5

4

16

15

14

13 12

2

1 Control panel display: The display provides information about the product. Use the menus on the display to establish
product settings.

2 Toner level gauges. These gauges indicate the estimated amount of toner left in each cartridge.

3 Ready light. This light indicates that the product is ready or is processing a job.

4 Attention light. This light indicates a problem with the product. View the display for a message.

5 Cartridge button. When the print cartridge door is closed, press this button to rotate the print cartridge carousel.

6 Wireless button (network models only). Press the button to open the Wireless Menu. Press and hold the button to
enable Wi-Fi Protected Setup (WPS) . The light indicates the state of the wireless connection.

7 Cancel button. Use the Cancel  button to cancel the current job.

8 OK button. Use the OK button to acknowledge a setting or to confirm an action to proceed.

9 Arrow buttons. Use the arrow buttons to navigate the menus and adjust certain settings.

10 Copy Menu button. Use the Copy Menu  button to open a copy settings menu.

11 Lighter/Darker button. Use the Lighter/Darker  button to control the brightness or darkness of a copy.

12 Color copy button. Use the Color button to start a color copy job.

13 Black and white copy button. Use the Black button to start a monochrome copy job.

14 # Copies button. Use the # Copies  button to set the number of copies that you want for the current copy job.

15 Back button. Use the Back  button to return to a previous menu, or to exit the menus and return to the Ready
state.

16 Setup button. Use the Setup  button to open the main menu options.
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2 Control panel menus

● Setup menu

● Function specific menus
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Setup menu
To open this menu, press the Setup  button. The following sub menus are available:

● Reports

● System Setup

● Service

● Network Setup

Reports menu

First level

Demo Page

Menu Structure

Config Report

Supplies Status

Network Summary (network models only)

Usage Page

PCL Font List

PS Font List

PCL6 Font List

Color Usage Log

Service Page

Diagnostics Page

Print Quality

System Setup menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

First level Second level Third level Values

Language   Lists available control-panel
display languages.

8 Chapter 2   Control panel menus ENWW



First level Second level Third level Values

Paper Setup Def. Paper Size  Letter

A4

Legal

Def. Paper Type  Lists available media types.

Tray 1 Paper Type Lists available media types.

Paper Size Lists available media sizes.

Paper Out Action  Wait Forever*

Cancel

Override

Print Quality Calibrate Color  Calibrate Now

After Power On

Energy Settings Sleep Delay  Off

1 Minute

15 Minutes*

30 Minutes

1 Hour

2 Hours

 Auto Power Down Auto-Off Delay Never

30 Minutes*

1 Hour

2 Hours

4 Hours

8 Hours

24 Hours

  Wake Events USB Job

LAN Job

Wireless Job

Button Press
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First level Second level Third level Values

Supply Settings Black Cartridge Very Low Setting Stop

Prompt

Continue*

Low Threshold (Range of 1-100)

Color Cartridges Very Low Setting Stop

Prompt

Continue

Print Black*

Low Threshold Cyan

(Range of 1-100)

Magenta

(Range of 1-100)

Yellow

(Range of 1-100)

 Imaging Drum Very Low Setting Stop*

Prompt

Continue

Low Threshold (Range of 1-100)

Store Usage Data  On Supply*

Not On Supply

Courier Font   Regular*

Dark

Allow Color   Yes*

No

Color Copy   On*

Off

Service menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

First level Second level Values

Cleaning Page   

Cleaning Mode   
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First level Second level Values

USB Speed  High*

Full

Less Paper Curl  On

Off*

Archive Print  On

Off*

Firmware Date   

Restore Defaults   

Network Setup menu (network models only)

In the following table, items that have an asterisk (*) indicate the factory default setting.

First level Second level Values

Wireless Menu Wi-Fi Protected Setup  

Run Network Test  

Turn Wireless On/Off On*

Off

TCP/IP Config  Automatic*

Manual

Auto Crossover  On*

Off

Network Services IPv4

IPv6

On*

Off

Show IP Address  Yes

No*

Link Speed  Automatic*

10T Full

10T Half

100TX Full

100TX Half

Restore Defaults   
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Function specific menus
The product features a function-specific menu for copying. To open this menu, press the Copy Menu

 button on the control panel.

Copy Menu

In the following table, items that have an asterisk (*) indicate the factory default setting.

First level Second level Values

# of copies  (Range of 1*-99)

ID Copy   

Reduce/Enlarge  Original=100%*

Legal to Letter=78%

Legal to A4=83%

A4 to Letter=94%

Letter to A4=97%

Full Page=91%

Fit to Page

2 pages per sheet

4 pages per sheet

Custom: 25 to 400%

Light/Dark  (Slider with a range of 11 settings.)

Optimize  Auto*

Mixed

Picture

Text

Paper Paper Size Lists available media sizes.

Paper Type Lists available media types.

Multi-Page Copy  On

Off*

Collation  On*

Off

Tray Select  Auto Select*

Tray 1

Two-Sided  1 to 1 sided*

1 to 2 sided
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First level Second level Values

Draft Mode  On

Off*

Image Adjustment Lightness (Slider with a range of 11 settings.)

Contrast (Slider with a range of 11 settings.)

Sharpen (Slider with a range of 11 settings.)

Background (Slider with a range of 11 settings.)

Color Balance Red

(Slider with a range of 11 settings.)

Green

(Slider with a range of 11 settings.)

Blue

(Slider with a range of 11 settings.)

Grayness (Slider with a range of 11 settings.)

Set as New Defaults   

Restore Defaults   
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings

● Change printer-driver settings for Windows

● Remove software for Windows

● Supported utilities for Windows

● Software for other operating systems
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Supported operating systems for Windows
The product comes with software for the following Windows® operating systems:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

Supported printer drivers for Windows
The product comes with software for Windows that allows the computer to communicate with the
product. This software is called a printer driver. Printer drivers provide access to product features,
such as printing on custom-sized paper, resizing documents, and inserting watermarks.

NOTE: The most recent drivers are available at www.hp.com/support/LJColorMFPM175.

Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with
the product (using a printer language). Check the installation notes and readme files on the product
CD for additional software and languages.

HP PCL 6 driver description

● Installs from the Add Printer wizard

● Provided as the default driver

● Recommended for printing in all supported Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP UPD PS driver description

● Available for download from the Web at www.hp.com/support/LJColorMFPM175

● Recommended for printing with Adobe® software programs or with other highly graphics-
intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript flash font support
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HP UPD PCL 5 driver description

● Available for download from the Web at www.hp.com/support/LJColorMFPM175

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● Designed for use in corporate Windows environments to provide a single driver for use with
multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows computer
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Change print job settings

Tool for changing the settings Method for changing the
settings

Duration of changes Hierarchy of changes

Software program settings On the File menu in the software
program, click Page Setup or a
similar command.

These settings are in effect for
the current print job only.

Settings changed here override
settings changed anywhere
else.

Printer Properties in the
software program

The steps vary for each
software program. This
procedure is most common.

1. On the File menu in the
software program, click
Print.

2. Select the product, and
then click Properties or
Preferences.

3. Change the settings on any
of the tabs.

These settings are in effect for
the current session of the
software program.

Settings changed here override
default printer driver settings
and default product settings.

Default printer driver settings 1. Open the list of printers on
your computer, and select
this product.

NOTE: This step varies
for each operating system.

2. Click Printer, and then
click Printing
Preferences.

3. Change the settings on any
of the tabs.

These settings remain in effect
until you change them again.

NOTE: This method changes
the default settings for the
printer driver for all software
programs.

You can override these settings
by changing settings in the
software program.

Default product settings Change product settings on the
control panel, or in the product
management software that
came with your product.

These settings remain in effect
until you change them again.

You can override these settings
by making changes with any
other tool.
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Change printer-driver settings for Windows

Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Remove software for Windows

Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Supported utilities for Windows
● HP Web Jetadmin

Other Windows components and utilities

● Software installer — automates the printing system installation

● Online Web registration

● HP LaserJet Scan
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Software for other operating systems

OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download
the HP Jetdirect printer installer for UNIX.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Mac

● Software for Mac

● Print with Mac

● Scan with Mac

● Solve problems with Mac
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Software for Mac

Supported operating systems for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5 and 10.6

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For
Mac OS X 10.6, Intel Core Processor Macs are supported.

Supported printer drivers for Mac

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, and Printer
Dialog Extensions (PDEs) for use with Mac OS X computers. The HP printer PPD and PDE files, in
combination with the built-in Apple PostScript printer drivers, provide full printing functionality and
access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wired network

Configure the IP address

The product IP address can be set manually, or it can be configured automatically via DHCP, BootP,
or AutoIP.

Manual configuration

Only the IPv4 protocol can be configured manually.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select Network Setup, and then press the OK button.

3. Use the arrow buttons to select TCP/IP Config, and then press the OK button.

4. Use the arrow buttons to select Manual, and then press the OK button.

5. Use the arrow buttons to set the IP address, and then press the OK button.

6. If the IP address is incorrect, use the arrow buttons to select No, and then press the OK button.
Repeat step 5 with the correct IP address, and then repeat step 5 for the subnet mask and
default gateway settings.

Automatic configuration

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select Network Setup, and then press the OK button.

3. Use the arrow buttons to select TCP/IP Config, and then press the OK button.

4. Use the arrow buttons to select Automatic, and then press the OK button.

It may take several minutes before the automatic IP address is ready for use.

NOTE: If you want to disable or enable specific automatic IP modes (such as BOOTP, DHCP, or
AutoIP), these settings can be changed by using the HP Utility.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Click the HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.

Install software for Mac computers on a wireless network

Before installing the product software and setting the product to connect to a wireless network, make
sure that the product is not connected to the network using a network cable.
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Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless
router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Remove software from Mac operating systems

You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Select Hewlett Packard.

4. Select HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.

Priority for print settings for Mac

Changes to print settings are prioritized depending on where the changes are made:
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NOTE: The names of commands and dialog boxes might vary depending on your software
program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change printer-driver settings for Mac

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click the
Save As... option and type a name
for the preset.

These settings are saved in the
Presets menu. To use the new
settings, you must select the saved
preset option every time you open a
program and print.

Mac OS X 10.5 and 10.6

1. From the Apple menu , click the

System Preferences menu and
then click the Print & Fax icon.

2. Select the product in the left side
of the window.

3. Click the Options & Supplies
button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

Supported utilities for Mac (network models only)

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected
to a TCP/IP-based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.
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Print with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one print job is waiting, pressing the Cancel  button clears the pint job that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size
and Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box,
and then select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Use watermarks with Mac

1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not
transparent.

4. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.

5. From the Text menu, select one of the standard messages, or select the Custom option and
type a new message in the box.

6. Select options for the remaining settings.
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Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Copies & Pages menu, and click the Manual Duplex tab or open the Manual Duplex
menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin, rotate the stack 180 degrees, and then place it
with the printed-side facing down in the input tray.

8. At the control panel, press the OK button.

Set the color options with Mac

Use the Color Options menu or the Color/Quality Options menu to control how colors are
interpreted and printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.
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3. Open the Color Options menu or the Color/Quality Options menu.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.

Use the Services menu with Mac

If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

1. On the File menu, click the Print option.

2. Open the Services menu.

3. To perform a maintenance task, do the following:

a. Select the Device Maintenance tab.

b. Select a task from the drop-down list.

c. Click the Launch button.

4. To go to various support Web sites for this product, do the following:

a. Select the Services on the Web tab.

b. Select an option from the menu.

c. Click the Go! button.
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Scan with Mac
Use the HP Scan software to scan images to a Mac computer.

1. Load the document onto the scanner glass or into the document feeder.

2. Open the Applications folder, and then click Hewlett-Packard. Double-click HP Scan.

3. Open the HP Scan menu and click Preferences. From the Scanner pop-up menu, select this
product from the list, and click Continue.

4. To use the standard preset settings, which produce acceptable results for images and text, click
the Scan button.

To use presets optimized for pictures or text documents, select a preset from the Scanning
Presets pop-up menu. To adjust the settings, click the Edit button. When you are ready to scan,
click the Scan button.

5. To scan more pages, load the next page and click Scan. Click Append to List to add the new
pages to the current list. Repeat until you have scanned all the pages.

6. Click the Save button, and then browse to the folder on your computer where you want to save
the file.

NOTE: To print the scanned images now, click the Print button.
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Solve problems with Mac
For information about solving problems with a Mac, see Solve common Mac problems on page 166.
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5 Connect the product

● Supported network operating systems (network models only)

● Use HP Smart Install to connect to a computer, a wired network, or a wireless network

● Connect with USB by using the software CD-ROM

● Connect to a network by using the software CD-ROM (network models only)
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Supported network operating systems (network models
only) 

The product supports the following operating systems for wireless printing:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

● Mac OS X v10.5 and v10.6

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating
systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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Use HP Smart Install to connect to a computer, a wired
network, or a wireless network

NOTE: This installation type is supported for Windows only.

The HP Smart Install allows you to install the product driver and software by connecting the product
to a computer through a USB cable.

NOTE: The installation CD is not required during an HP Smart Install. Do not insert the software
installation CD into the computer CD drive.

1. Turn the product on.

2. Connect the USB cable.

3. The HP Smart Install program should start automatically. Follow the onscreen instructions to
install the software.

● If the HP Smart Install program does not start automatically, AutoPlay might be disabled on
the computer. Browse the computer and double-click the HP Smart Install drive to run the
program.

● When the program prompts you to select a connections type, select the correct option.
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Connect with USB by using the software CD-ROM
CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using a USB cable option, and
then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button.

6. On the More Options screen, you can install more software, or click the Finish button.

7. Print a page from any program to make sure that the printing software is correctly installed.
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Connect to a network by using the software CD-ROM
(network models only)

The product can connect to wired or wireless networks.

NOTE: You cannot connect to a wired and wireless network simultaneously. Wired connections
take precedence.

Supported network protocols

Network models support the TCP/IP protocol, which is the most widely used and accepted networking
protocol. Many networking services utilize this protocol. This product also supports IPv4 and IPv6.
The following lists shows the networking services/protocols that are supported on the product.

● TCP/IP (IPv4 or IPv6)

● Port 9100

● LPR

● DHCP

● AutoIP

● SNMP

● Bonjour

● SLP

● WSD

● NBNS

Install the product on a wired network

Configure the IP address

The product IP address can be set manually, or it can be configured automatically via DHCP, BootP,
or AutoIP.

Manual configuration

Only the IPv4 protocol can be configured manually.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select Network Setup, and then press the OK button.

3. Use the arrow buttons to select TCP/IP Config, and then press the OK button.

4. Use the arrow buttons to select Manual, and then press the OK button.

5. Use the arrow buttons to set the IP address, and then press the OK button.

6. If the IP address is incorrect, use the arrow buttons to select No, and then press the OK button.
Repeat step 5 with the correct IP address, and then repeat step 5 for the subnet mask and
default gateway settings.
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Automatic configuration

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select Network Setup, and then press the OK button.

3. Use the arrow buttons to select TCP/IP Config, and then press the OK button.

4. Use the arrow buttons to select Automatic, and then press the OK button.

It may take several minutes before the automatic IP address is ready for use.

NOTE: If you want to disable or enable specific automatic IP modes (such as BOOTP, DHCP, or
AutoIP), these settings can be changed by using the HP Device Toolbox.

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the Next
button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Finish button.

8. Print a page from any program to make sure that the printing software is correctly installed.

Install the product on a wireless network 

Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless
router.
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NOTE: If this method is not successful, try using the wireless network setup using the USB cable
method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Install the software for a wireless product currently on the network

If the product already has an IP address on a wireless network and you want to install product
software on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Connect through a wireless network option, and then click the
Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Disconnect from the wireless network

If you want to disconnect the product from a wireless network, you can turn off the wireless unit in the
product.

1. At the product control panel, press and release the Wireless  button.

2. To confirm that the wireless unit is turned off, print a configuration page and then verify that the
status is specified as disabled on the configuration page.
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Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can
disrupt radio signals.

● Keep the wireless devices away from large masonry structures and other building structures.
These objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Advanced wireless setup

Wireless communication modes

You can use one of two wireless communication modes: infrastructure or ad-hoc.

Infrastructure wireless
network (recommended)

The product communicates with other devices on the network through a wireless router.

Ad-hoc wireless network The product communicates directly with other wireless devices without using a wireless
router.

All devices on the ad hoc network must have the following:

● 802.11b/g compatibility

● The same SSID

● The same subnet and channel

● The same 802.11b/g security settings

Wireless security

To make your wireless network easy to distinguish from other wireless networks, use a unique
network name (SSID) for your wireless router. Your wireless router might have a default network
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name, which is typically the manufacturer's name. For information on how to change the network
name, see the documentation that came with the wireless router.

To prevent other users from accessing your network, turn on WPA or WEP data encryption.

● Wired Equivalent Privacy (WEP): WEP is the original native security mechanism in the 802.11
standard. You create a unique key containing hexadecimal or alphanumeric characters, which
other users must provide before they can access your network.

● Wi-Fi Protected Access (WPA): WPA uses the temporal key integrity protocol (TKIP) for
encryption and employs 802.1X authentication. It addresses all known weaknesses of WEP. You
create a unique passphrase containing a combination of letters and numbers, which other users
must provide before they can access your network.

● WPA2 provides the advanced encryption standard (AES), and is an improvement over WPA.

Install the product on an ad-hoc wireless network

You can connect the product wirelessly to a computer through a peer-to-peer (ad-hoc) installation.

NOTE: To accomplish this task, you must temporarily connect the product to the network by using a
network cable.

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. Print a configuration page and a supplies status page.

4. Find the IP address on the configuration page.

5. Open a Web browser, and type the IP address into the address line. The HP Device Toolbox
opens.

6. Click the Networking tab, and select the Wireless Configuration link from the left pane.

7. Select the option to enable wireless networking, and then disconnect the network cable.

8. In the Configuration Method area, select the Create a new Ad hoc wireless network (peer-
to-peer) option.

9. Provide a unique network name, select a channel, and select the type of security to use.

10. Click the Apply button.
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Configure the network product

View or change network settings

Use the HP Device Toolbox to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has a format similar to this:

xxxx::xxxx:xxxx:xxxx:xxxx

2. Open the HP Device Toolbox by clicking the Start button, clicking the Programs or All
Programs group, clicking HP, clicking the product group, and then clicking HP Product
Settings.

3. Click the Networking tab to obtain network information. You can change settings as needed.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types

● Load paper trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in
this user guide. Paper or print media that does not meet these guidelines might cause poor print
quality, increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity
levels, or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner
of the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of
labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.
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Media type Do Do not

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight
specifications for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product
unless it is HP paper that has
been approved for use in this
product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type and
size

NOTE: If you change the page settings in the software program, those settings override any
settings in the printer driver.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.

5. Select a paper type from the Type is drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports various paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver
before printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions

Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

A4 210 x 297 mm (8.27 x 11.69 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

8.5 x 13 216 x 330 mm (8.5 x 13 in)

4 x 6 101.6 x 152.4 mm (4 x 6 in)

10 x 15 cm 101.6 x 152.4 mm (4 x 6 in)

5 x 8 127 x 203 mm (5 x 8 in)

RA4 215 x 305 mm (8.46 x 12.01 in)

A5 148 x 210 mm (5.83 x 8.27 in)

A6 105 x 148 mm (4.13 x 5.83 in)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)

16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in)

197 x 273 mm (7.75 x 10.75 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short
edge of the page as the width and the long edge as the length.

Table 6-2  Supported envelopes and postcards

Size Dimensions

Envelope #10 105 x 241 mm (4.13 x 9.49 in)

Envelope DL 110 x 220 mm (4.33 x 8.66 in)

Envelope C5 162 x 229 mm (6.93 x 9.84 in)

Envelope B5 176 x 250 mm (6.7 x 9.8 in)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.93 x 5.82 in)
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Size Dimensions

Double Japan Postcard Rotated

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short
edge of the page as the width and the long edge as the length.

Table 6-2  Supported envelopes and postcards (continued)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
LJColorMFPM175.

● Everyday

◦ Plain

◦ Light

◦ Bond

◦ Recycled

● Presentation

◦ Matte paper

◦ Glossy paper

◦ Heavy paper

◦ Heavy glossy paper

● Brochure

◦ Matte paper

◦ Glossy paper

◦ Tri-fold paper

◦ Extra heavy paper

◦ Extra heavy glossy paper

● Photo/Cover

◦ Matte cover paper

◦ Matte photo paper

◦ Photo glossy paper

◦ Glossy cards

● Other

◦ Color laser transparency

◦ Labels

◦ Letterhead

◦ Envelope

◦ Heavy envelope

◦ Preprinted

◦ Prepunched
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◦ Colored

◦ Rough

◦ Heavy rough

◦ HP Tough paper
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Load paper trays

Load the input tray

NOTE: When you add new paper make sure that you remove all of the paper from the input tray
and straighten the stack of new paper. Do not fan the paper. This reduces jams by preventing
multiple sheets of paper from feeding through the product at one time.

NOTE: When printing on small sizes or custom paper, load the short edge (width) into the product
first.

1. Load the paper face-up, top forward in the
input tray.

 

2. Adjust the guides until they are snug against
the paper.
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Tray capacity

Tray or bin Paper type Specifications Capacity

Input tray Paper 60-220 g/m2 (16-59 lb)

Print quality is assured for HP
media.

150 sheets of 75 g/m2 (20 lb)

Envelopes 60-90 g/m2 (16-24 lb) Up to 10 envelopes

Transparencies 0.12-0.13 mm (0.0047-.0.0051
in)

Up to 50 transparencies

Postcards 135-176 g/m2 (36-47 lb)

Glossy 130-220 g/m2 ()

Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following table.

Paper type How to load paper

Preprinted or letterhead ● Face up

● Top edge leading into the product

Prepunched ● Face up

● Holes toward the left side of the product

Envelope ● Face up

● Right short edge leading into the product
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● Solve problems with print cartridges or the imaging drum
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Print cartridge and imaging drum features

Feature Description

Part numbers ● Black print cartridge: CE310A

● Cyan print cartridge: CE311A

● Yellow print cartridge: CE312A

● Magenta print cartridge: CE313A

● Imaging drum: CE314A

NOTE: The selectibility number for all print cartridges and the imaging drum is 126A.

Accessibility ● Print cartridges and the imaging drum can be installed and removed by using one hand.

Environmental
features

● Recycle print cartridges by using the HP Planet Partners return and recycling program.

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.
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Supplies views

Print cartridge views

1

2
1 Print cartridge memory tag

Imaging drum views

1

1 Imaging drum memory tag
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Manage print cartridges and the imaging drum
Correctly using, storing, and monitoring the print cartridge and imaging drum can help ensure high-
quality print output.

Change settings for print cartridges or the imaging drum

Print when a print cartridge or imaging drum is at estimated end of life

<Supply> Low message—where <Supply> is the color print cartridge or the imaging drum: The
product indicates when a supply level is low. Actual life remaining may vary. Consider having a
replacement available to install when print quality is no longer acceptable. The supply does not need
to be replaced now.

<Supply> Very Low message—where <Supply> is either the color print cartridge or imaging drum or
a combination of multiple print cartridges and/or the imaging drum: The product indicates when a
supply level is very low. Actual supply life remaining may vary. Consider having a replacement
available to install when print quality is no longer acceptable. The supply does not need to be
replaced now unless the print quality is no longer acceptable.

Once an HP print cartridge has reached “very low”, HP’s Premium Protection Warranty on that supply
has ended.

The imaging drum installed in this product is covered by the product warranty. Replacement imaging
drums have a one-year limited warranty from the date of installation. The imaging drum installation
date displays on the supplies status page.

Change the Very Low settings from the control panel

You can change the setting at any time, and you do not have to reset it when you install a new print
cartridge or imaging drum.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the Supply Settings menu, and then press the OK button.

4. Use the arrow buttons to select the Black Cartridge menu, the Color Cartridges menu, or the
Imaging Drum menu, and then press the OK button.

5. Use the arrow buttons to select the Very Low Setting menu, and then press the OK button.

6. Select one of the following options.

● Select the Continue option to set the product to alert you that the print cartridge or imaging
drum is very low, but to continue printing.

● Select the Stop option to set the product to stop printing until you replace the print cartridge
or imaging drum.

● Select the Prompt option to set the product to stop printing and prompt you to replace the
print cartridge or imaging drum. You can acknowledge the prompt and continue printing.

● On the Color Cartridges menu only, select Print Black to alert you when the print
cartridge is very low, but to continue printing in black only.
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Replacement instructions

Replace the print cartridges

When a print cartridge approaches the estimated end of its useful life, you can continue printing with
the current print cartridge until it no longer yields acceptable print quality.

Once an HP print cartridge has reached “very low’, the HP Premium Protection Warranty on that
supply has ended. All print defects or print cartridge failures incurred when an HP supply is used in
continue at very low mode will not be considered to be defects in materials or workmanship in the
supply under the HP Print Cartridge Warranty Statement.

1. Some error messages or status messages
cause the product to rotate the print cartridge
carousel to the affected cartridge
automatically. If the print cartridge that needs
to be replaced is not in the correct position,
press the Cartridge  button to rotate the
print cartridge carousel to the cartridge color
that you want to replace.

NOTE: All doors must be closed when
pressing the Cartridge  button. Also, the
imaging drum must be installed for the
Cartridge  button to work.

NOTE: Wait until the Rotating message
and the rotation sounds stop before opening
the print cartridge door.

 

2. Open the print cartridge door.  
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3. Grasp the old print cartridge by the center
handle and remove it.

 

4. Remove the new print cartridge from the
packaging. Place the used print cartridge in
the bag and box for recycling.

CAUTION: To prevent damage to the print
cartridge, hold the print cartridge at each end.
Do not touch the roller on the print cartridge.

 

5. Grasp both sides of the print cartridge and
gently rock the print cartridge to distribute the
toner evenly inside the print cartridge.

 

6. Grasp the print cartridge by the center handle
and remove the protective plastic shield.

NOTE: Do not touch the print cartridge
roller. Fingerprints on the roller can cause
print-quality problems.

 

7. Remove the sealing tape from the print
cartridge. Place the tape in the print-cartridge
box to return for recycling.
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8. Grasp the print cartridge by the center handle
and insert into the product.

NOTE: Compare the color label on the print
cartridge to the color label in the carousel slot
to make sure the print cartridge color matches
the carousel position.

CAUTION: If toner gets on your clothing,
wipe it off with a dry cloth and wash the
clothing in cold water. Hot water sets toner
into the fabric.

 

9. Close the print cartridge door.

NOTE: After closing the print cartridge door,
the control panel shows the Calibrating...
message. Allow a few minutes for the product
to calibrate.

NOTE: If replacing another print cartridge,
you must close the print cartridge door before
pressing the Cartridge  button of the next
print cartridge.

You do not need to wait for the product to
calibrate when replacing the second print
cartridge. Instead, press the Cartridge 
button to rotate the carousel into position.
After you have replaced the print cartridges,
the product calibrates.

 

NOTE: When printing, if you receive the status alert message Wrong Cartridge in <Color> Slot,
remove the print cartridge from the specified slot and compare the color label on the print cartridge to
the color label in the slot to determine the correct print cartridge for the slot.
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Replace the imaging drum

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on the supplies status page. The HP Premium Protection Warranty applies
only to the print cartridges for the product.

1. Open the print cartridge door.  

2. Open the front cover.  
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3. Lift the two levers that hold the imaging drum.  

4. Remove the old imaging drum.  

5. Remove the new imaging drum from the
packaging. Place the used imaging drum in
the bag and box for recycling.
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6. Remove the protective shielding from the new
imaging drum.

CAUTION: To prevent damage, do not
expose the imaging drum to light. Cover it
with a piece of paper.

CAUTION: Do not touch the green roller.
Fingerprints on the imaging drum can cause
print-quality problems.

 

7. Insert the new imaging drum in the product.  

8. Lower the two levers that hold the imaging
drum.
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9. Close the front cover.  

10. Close the print cartridge door.

NOTE: After closing the print cartridge door,
the control panel shows the Calibrating...
message. Allow a few minutes for the product
to calibrate.

 

Recycle supplies

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-
addressed shipping label contained in the box. To use the UPS label, give the package to the UPS
driver during your next delivery or pickup, or take it to an authorized UPS drop-off center. (Requested
UPS Ground pickup will be charged normal pick up rates.) For the location of a local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com. If you are returning the package via the FedEx
label, give the package to either the U.S. Postal Service carrier or FedEx driver during your next pick-
up or delivery. (Requested FedEx Ground pickup will be charged normal pick up rates). Or, you can
drop off your packaged print cartridge(s) at any U.S. Post Office or any FedEx shipping center or
store. For the location of the nearest U.S. Post Office, please call 1-800-ASK-USPS or visit
www.usps.com. For the location of the nearest FedEx shipping center/store, please call 1-800-
GOFEDEX or visit www.fedex.com. For more information, or to order additional labels or boxes for
bulk returns, visit www.hp.com/recycle or call 1-800-340-2445. Information is subject to change
without notice.

Print-cartridge and imaging drum storage

Do not remove the print cartridge or imaging drum from their packages until you are ready to use
them.
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HP policy on non-HP supplies

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges and imaging
drums, either new or remanufactured.

NOTE: For HP printer products, the use of a non-HP print cartridge or a refilled print cartridge does
not affect either the warranty to the customer or any HP support contract with the customer. However,
if product failure or damage is attributable to the use of a non-HP print cartridge or refilled print
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the
cartridge is non-HP or used. HP will help determine if the cartridge is genuine and take steps to
resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP or used supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).

68 Chapter 7   Print cartridges and imaging drum ENWW

http://www.hp.com/go/anticounterfeit
http://www.hp.com/go/anticounterfeit


Solve problems with print cartridges or the imaging drum

Check the print cartridges and imaging drum

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the supplies status page to find the
part number for the correct genuine HP print cartridge.

Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett-Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge that has the words “HP” or “Hewlett-Packard” on it, or has
the HP logo on it.

Genuine HP print cartridge or imaging
drum

1. The product control panel or the supplies status page indicates “Very Low”
status when the cartridge has reached the end of its estimated life. Replace
the print cartridge if print quality is no longer acceptable.

2. Print a print quality page from the Reports menu on the control panel. If
streaks or marks are in one color on the page, you might have a defect in
that color cartridge. See the instructions in this document for interpreting the
page. Replace the print cartridge if necessary.

3. Visually inspect the print cartridge for damage. See the instructions that
follow. Replace the print cartridge if necessary.

4. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repetitive defects section in this document to identify the cause of the
problem.
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Inspect the print cartridges and imaging drum for damage

1. Remove the print cartridge from the product, and examine for damage.

2. If the print cartridge does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem is resolved.

3. If the problem is not resolved, remove the imaging drum from the product, and examine the
surface.

CAUTION: Do not touch the green roller. Fingerprints on the imaging drum can cause print-
quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the
imaging drum.
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Repeating defects

If defects repeat at any of the following intervals on the page, a print cartridge or the imaging drum
might be damaged.

● 22 mm (print cartridge)

● 26 mm (imaging drum)

● 29 mm (print cartridge)

● 94 mm (imaging drum)

Print the supplies status page

Use the control panel to print configuration and supplies status pages that give details about the
product and its current settings.

1. On the product control panel, press the Setup  button.

2. Use the arrow buttons to select the Reports menu, and then press the OK button.

3. Use the arrow buttons to select the Supplies Status item, and then press the OK button.

Page Description

Configuration page Prints a list of the product settings

Supplies status page The supplies status page includes the following information:

● Approximate percentage of print cartridge life remaining

● Warranty for print cartridges and imaging drum (if those supplies are at a “very low”
level)

● Part numbers for HP print cartridges and the imaging drum

● Number of pages printed on each print cartridge

● Information about ordering new HP print cartridges and recycling used HP print
cartridges

● The imaging drum's estimated life remaining and installation date appear on the
supplies status page.

ENWW Solve problems with print cartridges or the imaging drum 71



Interpret the print quality page

1. On the product control panel, press the Setup  button.

2. Use the arrow buttons to select the Reports menu, and then press the OK button.

3. Use the arrow buttons to select the Print Quality item, and then press the OK button.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the print cartridge
is probably causing the problem.
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Interpret control panel messages for print cartridges or the imaging drum

Control panel message Description Recommended action

10.0004 Supply Error

10.1004 Supply memory error

There is a communication failure with the
imaging drum.

● Turn the product off and then on.

● If the error persists, replace the
imaging drum.

● If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

10.000X Supply memory error

10.100X Supply memory error

There is a communication failure with one of
the print cartridges. "X" indicates which
cartridge: 0=black, 1=cyan, 2=magenta,
3=yellow.

● Turn the product off and then on.

● Verify that the print cartridge is
installed correctly. Remove and
reinstall the print cartridges.

● If the error persists, replace the print
cartridges.

● If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Black cartridge is low The print cartridge is nearing the estimated
end of its useful life.

Printing can continue, but consider having a
replacement supply on hand.

Black cartridge is very low The print cartridge is at the estimated end of
its useful life.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.

Cyan cartridge is low The print cartridge is nearing the estimated
end of its useful life.

Printing can continue, but consider having a
replacement supply on hand.

Cyan cartridge is very low The print cartridge is at the estimated end of
its useful life.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.
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Control panel message Description Recommended action

Door open The print cartridge door is open. Close the print cartridge door.

Jam in cartridge area The product has detected a paper jam in the
print cartridge area.

Clear the jam from the area indicated in the
message, and then follow the control panel
instructions.

Magenta cartridge is low The print cartridge is nearing the estimated
end of its useful life.

Printing can continue, but consider having a
replacement supply on hand.

Magenta cartridge is very low The print cartridge is at the estimated end of
its useful life.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.

Replace <Color> Cartridge The indicated print cartridge is at the
estimated end of its useful life. The product
is customer-configured to stop when the
print cartridge level is very low.

Replace the print cartridge, or reconfigure
the product to continue printing after the
print cartridge reaches the “very low” level.

Replace <Color>. Printing Black. The indicated print cartridge is at the
estimated end of its useful life. The product
is customer-configured to print with the
black cartridge only, until the very low print
cartridge is replaced.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.

Replace Supplies Multiple supplies are at the estimated end of
their useful life, and the product is
customer-configured to stop when the
supply level is very low.

Replace the supplies, or reconfigure the
product to continue printing after the
supplies reach the “very low” level.
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Control panel message Description Recommended action

Replace Supplies. Printing Black. One or more of the print cartridges is at the
estimated end of its useful life. The product
is customer-configured to print with the
black cartridge only, until the very low print
cartridges are replaced.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.

Supplies are low One or more of the print cartridges, or a
combination of print cartridge(s) and the
imaging drum, are nearing the estimated
end of their useful life.

Printing can continue, but consider having a
replacement supply on hand.

Supplies are very low One or more of the print cartridges, or a
combination of print cartridge(s) and the
imaging drum, have reached the estimated
end of their useful life.

To ensure optimal print quality, HP
recommends replacing the print cartridge or
imaging drum at this point. You can
continue printing until you notice a decrease
in print quality. Actual cartridge life may
vary.

Once an HP print cartridge has reached
“very low”, HP's premium Protection
Warranty on that supply has ended. All print
defects or cartridge failures incurred when
an HP supply is used in continue at very low
mode will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.

The imaging drum installed in this product is
covered by the product warranty.
Replacement imaging drums have a one-
year limited warranty from the date of
installation. The imaging drum installation
date displays on the supplies status page.

Supplies in wrong positions The print cartridges are installed in the
incorrect slots.

Make sure that each print cartridge is
installed in the correct slot.

Used <color> cartridge is installed A used supply has been installed. The print
cartridge is most likely a refilled cartridge.

If you believe you purchased a genuine HP
supply, visit this HP Web address:
www.hp.com/go/anticounterfeit.

If product failure or damage is attributable to
the use of a non-HP print cartridge or
refilled print cartridge, HP will charge its
standard time and materials charges to
service the product for the particular failure
or damage. Supply status and features that
depend on it are unavailable with used
cartridges.
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Control panel message Description Recommended action

Used cartridges installed Used supplies have been installed. The
print cartridges are most likely refilled
cartridges.

If you believe you purchased a genuine HP
supply, visit this HP Web address:
www.hp.com/go/anticounterfeit.

If product failure or damage is attributable to
the use of a non-HP print cartridge or
refilled print cartridge, HP will charge its
standard time and materials charges to
service the product for the particular failure
or damage. Supply status and features that
depend on it are unavailable with used
cartridges.

Used supplies in use Used supplies have been installed. The
print cartridges are most likely refilled
cartridges.

If you believe you purchased a genuine HP
supply, visit this HP Web address:
www.hp.com/go/anticounterfeit.

If product failure or damage is attributable to
the use of a non-HP print cartridge or
refilled print cartridge, HP will charge its
standard time and materials charges to
service the product for the particular failure
or damage. Supply status and features that
depend on it are unavailable with used
cartridges.

Wrong Cartridge in <Color> Slot A print cartridge is installed incorrectly in the
indicated slot.

Make sure that each print cartridge is
installed in the correct slot.

Yellow cartridge is low The print cartridge is nearing the estimated
end of its useful life.

Printing can continue, but consider having a
replacement supply on hand.

Yellow cartridge is very low The print cartridge is at the estimated end of
its useful life.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You can continue printing until
you notice a decrease in print quality. Actual
cartridge life may vary.

Once an HP supply has reached “very low”,
HP's premium Protection Warranty on that
supply has ended. All print defects or
cartridge failures incurred when an HP
supply is used in continue at very low mode
will not be considered to be defects in
materials or workmanship in the supply
under the HP Print Cartridge Warranty
Statement.
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8 Print tasks

● Cancel a print job

● Basic print tasks with Windows

● Additional print tasks with Windows
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Cancel a print job
1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product

control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print
spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click
Printers and Faxes. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and
Sound, click Printer. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

Get help for any printing option with Windows

1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, or if you select a
different shortcut, all your adjustments are
lost.
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5. Select the print options for the new shortcut.

NOTE: You can select the print options on
this tab or on any other tab in the printer
driver. After selecting options on other tabs,
return to the Printing Shortcuts tab before
continuing with the next step.

 

6. Click the Save As button.  

7. Type a name for the shortcut, and click the
OK button.

 

Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

ENWW Basic print tasks with Windows 83



3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.

Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the Save button, and then click the Close button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, click the More... option.

5. Select the category of paper types that best describes your paper, and then click the paper type
that you are using.

Print on both sides (duplex) with Windows

Manually print on both sides (duplex) with Windows

1. Load paper face-up in the input tray.  
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2. On the File menu in the software program,
click Print.

 

3. Select the product, and then click the
Properties or Preferences button.

 

4. Click the Finishing tab.  
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5. Select the Print on Both Sides (Manually)
check box. Click the OK button to print the
first side of the job.

 

6. Retrieve the printed stack from the output bin,
and, maintaining the paper orientation, place
it with the printed-side facing down in the
input tray.

 

7. At the computer, click the Continue button to
print the second side of the job. If at the
product, press the OK button.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

ENWW Basic print tasks with Windows 87



4. Select the number of pages per sheet from
the Pages Per Sheet drop-down list.

 

5. Select the correct Print Page Borders, Page
Order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select
the Rotated option.
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Set color options with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. In the Color Options area, click the Manual option, and then click the Settings button.

5. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Additional print tasks with Windows

Print colored text as black with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Print all Text as Black check box. Click the OK button.
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Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Type is drop-down list, click the
More... option.

 

5. Select the Other option.  

6. Select the option for the type of paper you are
using, and click the OK button.

 

ENWW Additional print tasks with Windows 93



Print on special paper, labels, or transparencies

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Type is drop-down list, click the
More... option.

 

5. Select the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

6. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. Click the Use different paper check box, and
then select the necessary settings for the
front cover, other pages, and back cover.

 

Scale a document to fit page size

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print Document On option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First Page Only check box. Otherwise,
the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Click the Print on Both Sides (Manually)
check box.

 

5. In the Booklet Printing drop-down list, select
a binding option. The Pages Per Sheet
option automatically changes to 2 Pages Per
Sheet.
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9 Color

● Adjust color

● Use the HP EasyColor option for Windows

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.
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4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color toner.

6. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text,
graphics, and photographs.

Table 9-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.
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Setting description Setting options

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations.
Select this option when uniform and smooth area fills are
important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale
viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Table 9-1  Manual color options (continued)
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Use the HP EasyColor option for Windows
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in the HP PCL 6 printer driver, so you do not need to
make manual color adjustments. To disable the option so you can manually adjust the color settings,
open the Color tab, and click the HP EasyColor check box to clear it.
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Match colors
For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers
and computer monitors use different methods of producing color. Monitors display colors by using
light pixels that use an RGB (red, green, blue) color process, but printers print colors by using a
CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.
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10 Copy

● Use copy functions

● Copy settings

● Copy photos

● Copy mixed size originals

● Copy on both sides manually (duplex)
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Use copy functions

One-touch copy

1. Load the document onto the scanner glass or into the document feeder.

2. Press the Black or Color button to start copying.

Multiple copies

1. Load the document onto the scanner glass or into the document feeder.

2. On the control panel, touch the # Copies  button.

3. Use the arrow buttons to change the number of copies.

4. Press the Black or Color button to start copying.
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Copy a multiple-page original

1. Insert the originals into the document feeder face-up, and then adjust the guides until they are
snug against the paper.

2. Press the Black or Color button to start copying.
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Copy identification cards

Use the ID Copy feature to copy both sides of identification cards, or other small-size documents,
onto the same side of one sheet of paper. The product prompts you to copy the first side and then to
place the second side on a different area of the scanner glass and copy again. The product prints
both images at the same time.

1. Load the document onto the scanner glass.  

2. On the control panel, press the Copy Menu 
button.

 

3. Use the arrow buttons to select the ID Copy
menu, and then press the OK button.

 

4. When prompted by the control panel display,
turn the document over, place it on a different
portion of the scanner glass, and then press
the OK button.

 

5. When prompted by the control panel display,
press the Black or Color button to start
copying.

The product copies all pages onto one side of
a sheet of paper.
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Cancel a copy job

1. Press the Cancel  button on the product control panel.

NOTE: If more than one process is running, pressing the Cancel  button clears the current
process and all pending processes.

2. Remove the remaining pages from the document feeder.

Reduce or enlarge a copy

1. Load the document onto the scanner glass or
into the document feeder.

 

2. On the control panel, press the Copy Menu 
button.

 

3. Use the arrow buttons to select the Reduce/
Enlarge menu item, and then press the OK
button. Use the arrow buttons to scroll
through the options, and then press the OK
button select the option.

 

4. Press the Black or Color button to start
copying.
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Collate a copy job

1. Load the document onto the scanner glass or
into the document feeder.

 

2. On the control panel, press the Copy Menu 
button.

 

3. Use the arrow buttons to select the Copy
Collation menu item, and then press the OK
button. Use the arrow buttons to scroll
through the options, and then press the OK
button to select an option.

 

4. Press the Black or Color button to start
copying.
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Make color or black and white copies

1. Load the document onto the scanner glass or into the document feeder.

2. On the control panel, press the Black or Color button to start copying.

Copy settings

Change copy quality

The following copy-quality settings are available:

● Auto Select: Use this setting when you are not concerned about the quality of the copy. This is
the default setting.

● Mixed: Use this setting for documents that contain a mixture of text and graphics.

● Text: Use this setting for documents that contain mostly text.

● Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.
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2. On the control panel, press the Copy Menu 
button.

 

3. Use the arrow buttons to select the Optimize
menu, and then press the OK button.

 

4. Use the arrow buttons to select the correct
option, and then press the OK button.

 

5. Press the Black or Color button to start
copying.

 

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document
feeder scanning strip, and the white plastic
backing with a soft cloth or sponge that has
been moistened with nonabrasive glass
cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might
seep and damage the product.
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4. Dry the glass and white plastic with a chamois
or a cellulose sponge to prevent spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.

 

Adjust the lightness or darkness for copies

1. Load the document onto the scanner glass or
into the document feeder.

 

2. On the control panel, press the Lighter/Darker
 button.

 

3. Use the arrow buttons to adjust the setting.  

4. Press the Black or Color button to start
copying.

 

Define custom copy settings

When you change the copy settings at the control panel, the custom settings remain in effect for
approximately 2 minutes after the job completes, and then the product returns to the default settings.
To immediately return to the defaults, press the Cancel  button.

Print or copy edge-to-edge

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x
13.7 in), leaving a 4 mm (1/6 in) unprintable border around the page.

Considerations for printing or scanning documents with cropped edges:

● When the original is smaller than the output size, move the original 4 mm (1/6 in) away from the
corner indicated by the icon on the scanner. Recopy or scan in this position.

● When the original is the size of the desired output, use the Reduce/Enlarge feature to reduce
the image so the copy is not cropped.
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Set the paper size and type for copying on special paper

1. On the control panel, press the Copy Menu 
button.

 

2. Use the arrow buttons to select the Paper
menu item, and then press the OK button.

 

3. From the list of paper sizes, select the name
of the paper size that is in Tray 1, and then
press the OK button..

 

4. From the list of paper types, select the name
of the paper type that is in Tray 1, and then
press the OK button..

 

5. Press the Black or Color button to start
copying.

 

Restore copy default settings

1. On the control panel, press the Copy Menu 
button.

 

2. Use the arrow buttons to select the Restore
Defaults menu item, and then press the OK
button.
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Copy photos
NOTE: Copy photos from the scanner glass, not from the document feeder.

1. Place the photo on the scanner glass, picture-side down at the upper left corner of the glass,
and close the scanner lid.

2. On the control panel, press the Copy Menu  button.

3. Use the arrow buttons to select the Optimize menu item, and then press the OK button.

4. Use the arrow buttons to select the Picture option, and then press the OK button.

5. Press the Black or Color button to start copying.
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Copy mixed size originals
Use the scanner glass to make copies of mixed size originals.

NOTE: You can use the document feeder to copy mixed size originals only if the pages share a
common dimension. For example, you can combine Letter and Legal size pages because they have
the same width. Stack the pages so the top edges are even with each other and so the pages have
the same width but varying lengths.

1. In Tray 1, load paper that is large enough for the largest page in the original document.

2. Place one page of the original document face down in the upper left corner of the scanner glass.

3. On the control panel, press the Copy Menu  button.

4. Use the arrow buttons to select the Paper menu item, and then press the OK button..

5. From the list of paper sizes, touch the name of the paper size that is loaded in Tray 1, and then
press the OK button..

6. From the list of paper types, touch the name of the paper type that is loaded in Tray 1, and then
press the OK button..

7. Press the Black or Color button to start copying.

8. Repeat these steps for each page.
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Copy on both sides manually (duplex)
1. Load the first page of the document onto the

scanner glass or into the document feeder.
 

2. On the control panel, press the Black or
Color button to start copying.

 

3. Remove the printed copy from the output bin,
rotate the stack 180 degrees, and then load
the page with the printed side down into Tray
1.

 

4. Load the next page of the document onto the
scanner glass or into the document feeder.
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5. Press the Black or Color button to start
copying.

 

6. Repeat these steps until the copy is complete.  
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11 Scan

● Use scan functions

● Scan settings
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Use scan functions

Scan methods

Perform scan jobs in the following ways.

● Scan from the computer by using HP Scan software

● Scan from TWAIN-compliant or Windows Imaging Application (WIA)-compliant software

NOTE: To learn about and use text-recognition software, install the Readiris program from the
software CD. Text-recognition software is also known as optical character recognition (OCR)
software.

Scan by using HP Scan software (Windows)

1. Double-click the HP Scan icon on the computer desktop.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.

Scan by using other software

The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product
works with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning
devices and with Macintosh-based programs that support TWAIN-compliant scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If
the program does not start automatically, the image goes to the TWAIN-compliant program
immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.
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Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner
or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see
the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the Hardware
and Sound folder for Windows Vista and Windows 7), double-click the product icon. This opens the
standard Microsoft WIA Wizard, which enables you to scan to a file.

Scan by using optical character recognition (OCR) software

The Readiris OCR program is included on a separate CD that shipped with the product. To use the
Readiris program, install it from the appropriate software CD, and then follow the instructions in the
online Help.

Cancel a scan

To cancel a scan job, use one of the following procedures.

● On the product control panel, press the Cancel  button.

● Click the Cancel button in the on-screen dialog box.
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Scan settings

Scanner resolution and color

If you are printing a scanned image, and the quality is not what you expected, you might have
selected a resolution or color setting in the scanner software that does not match your needs.
Resolution and color affect the following features of scanned images:

● Image clarity

● Texture of gradations (smooth or rough)

● Scan time

● File size

Scanning resolution is measured in pixels per inch (ppi).

NOTE: Scanning ppi levels are not interchangeable with printing dpi (dots per inch) levels.

Color, grayscale, and black and white define the number of colors possible. You can adjust the
scanner hardware resolution to up to 1200 ppi. 

The resolution and color guidelines table lists simple tips that you can follow to meet your scanning
needs.

NOTE: Setting the resolution and color to a high value can create large files that take up disk space
and slow the scanning process. Before setting the resolution and color, determine how you are going
to use the scanned image.

124 Chapter 11   Scan ENWW



Resolution and color guidelines

The following table describes the recommended resolution and color settings for different types of
scan jobs.

NOTE: The default resolution is 200 ppi.

Intended use Recommended resolution Recommended color settings

Fax 150 ppi ● Black and White

E-mail 150 ppi ● Black and White, if the image does not require
smooth gradation

● Grayscale, if the image requires smooth
gradation

● Color, if the image is in color

Edit text 300 ppi ● Black and White

Print (graphics or text) 600 ppi for complex graphics, or if you
want to significantly enlarge the
document

300 ppi for normal graphics and text

150 ppi for photos

● Black and White for text and line art

● Grayscale for shaded or colored graphics and
photos

● Color, if the image is in color

Display on screen 75 ppi ● Black and White for text

● Grayscale for graphics and photos

● Color, if the image is in color

Color

You can set the color values to the following settings when scanning.

Setting Recommended use

Color Use this setting for high-quality color photos or documents in which the color is
important.

Black and White Use this setting for text documents.

Grayscale Use this setting when file size is an issue or when you want to scan a document or
photograph quickly.
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Scan quality

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner glass and white plastic backing.

1. Use the power switch to turn off the product,
and then unplug the power cord from the
electrical socket.

 

2. Open the scanner lid.  

3. Clean the scanner glass, the document
feeder scanning strip, and the white plastic
backing with a soft cloth or sponge that has
been moistened with nonabrasive glass
cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might
seep and damage the product.

 

4. Dry the glass and white plastic with a chamois
or a cellulose sponge to prevent spotting.

 

5. Plug in the product, and then use the power
switch to turn on the product.
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12 Manage and maintain the product

● Print information pages

● Change the product settings from a computer

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Clean the product

● Product updates
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Print information pages
Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System Setup menu on the control panel.

Menu item Description

Demo Page Prints a color page that demonstrates print quality.

Menu Structure Prints a map of the control panel-menu layout. The active settings for each menu
are listed.

Config Report Prints a list of all the product settings. Includes network information when the
product is connected to a network.

Supplies Status Prints the status for each print cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part number

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP
print cartridges

Network Summary Prints a list of all product network settings

Usage Page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were
jammed or mispicked in the product, monochrome (black and white) or color
pages; and reports the page count

HP LaserJet Pro 100 color MFP M175nw only: prints a page that lists the
information above, and the monochrome (black and white) or color pages printed,
number of memory cards inserted, number of PictBridge connections, and the
PictBridge page count

PCL Font List Prints a list of all the PCL fonts that are installed.

PS Font List Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List Prints a list of all the PCL6 fonts that are installed

Color Usage Log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service Page Prints the service report

Diagnostics Page Prints the calibration and color diagnostics pages

Print Quality Prints a color test page which can be useful for diagnosing print quality defects.

1. Press Setup  button to open the menus.

2. Use the arrow buttons to select the Reports menu, and then press the OK button.
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3. Use the arrow buttons to select the report you want to print, and then press the OK button to
print the report.

4. Press the Cancel  button to exit the menus.
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Change the product settings from a computer
NOTE: This tool is available only if you performed a full installation when you installed the product.

To change the product settings from a computer, open the HP Device Toolbox.

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

The table below describes the basic product settings.

Tab or section Description

Status tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the life remaining of
HP supplies, with 0% indicating that a supply is empty.

● Supplies Status: Shows the approximate percent life remaining of HP supplies.
Actual supply life remaining can vary. Consider having a replacement supply
available to install when print quality is no longer acceptable. The supply does not
need to be replaced unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration
page.

● Network Summary: Shows the information found on the product network
configuration page.

● Reports: Allows you to print the configuration and supplies status pages that the
product generates.

● Color Usage Log: Shows a log that shows the user name, application name, and
color usage information on a job-by-job basis.

● Event Log: Shows a list of all product events and errors.

● Support button: Provides a link to the product support page. The Support button
can be password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.
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Tab or section Description

System tab

Provides the ability to configure
the product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product,
including calibration settings.

● Print Density: Allows you to change the contrasts, highlights, midtones, and
shadows values for each supply.

● Paper Types: Allows you to configure print modes that correspond to the media
types that the product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set or change the Administrator password.

● Support button: Provides a link to the product support page. The Support button
can be password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the administrator before changing settings on this tab.

Print tab

Provides the ability to change
default print settings from your
computer.

● Printing: Change the default product print settings, such as number of copies and
paper orientation. These are the same options that are available on the control
panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: View and change the PS settings.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the
product when it is connected to an IP-based network. This tab does not appear if the
product is directly connected to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.

Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. Management is proactive, allowing network
administrators the ability to resolve issues before users are affected. Download this free, enhanced-
management software at www.hp.com/go/webjetadmin. 

Device plug-ins can be installed into HP Web Jetadmin to provide support for specific product
features. The HP Web Jetadmin software can automatically notify you when new plug-ins are
available. On the Product Update page, follow the directions to automatically connect to the HP Web
site and install the latest device plug-ins for your product.

NOTE: Browsers must be Java™-enabled. Browsing from a Mac OS is not supported.
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Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain
the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

 

Assign a system password (network models only)

Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Device Toolbox.

2. Click the System tab.

3. On the left side of the window, click the Product Security menu.

4. Type the password in the Password box, and type it again in the Confirm Password box.

5. Click the Apply button. Make note of the password and store it in a safe place.
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Economy settings

Sleep mode

The adjustable sleep mode feature reduces power consumption when the product has been inactive
for an extended period. You can set the length of time before the product enters sleep mode.

NOTE: This mode does not affect product warm-up time.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the Energy Settings menu, and then press the OK button.

4. Use the arrow buttons to select the Sleep Delay menu, and then press the OK button.

5. Use the arrow buttons to select a sleep delay time period, and then press the OK button.

Low power settings

Low power mode is an energy-saving feature of this product. After a user-specified time period (the
low power delay period), the product automatically reduces its power consumption. The product
returns to the Ready state when it receives a wake event.

Set the low power delay period

You can change how long the product remains idle before it enters low power mode.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the Energy Settings menu, and then press the OK button.

4. Use the arrow buttons to select the Auto Power Down menu, and then press the OK button.

5. Use the arrow buttons to select the Auto-Off Delay menu, and then press the OK button.

6. Use the arrow buttons to select a low power delay time period, and then press the OK button.

Set the wake events

You can select which events cause the product to return to the Ready state after being in low power
mode.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the Energy Settings menu, and then press the OK button.

4. Use the arrow buttons to select the Auto Power Down menu, and then press the OK button.

5. Use the arrow buttons to select the Wake Events menu, and then press the OK button.

6. Use the arrow buttons to select the events that you want to return the product to the Ready
state, and then press the OK button.
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Archive print

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.

1. On the control panel, press the Setup  button.

2. Use the arrow buttons to select the Service menu, and then press the OK button.

3. Use the arrow buttons to select the Archive Print item, select On or Off, and then press the OK
button.
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Clean the product

Clean the document feeder pickup rollers and separation pad

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document feeder rollers and separation pad.

1. Open the document feeder cover.

2. Use a moist, lint-free cloth to wipe both pickup rollers and the separation pad to remove dirt.

3. Close the document feeder cover.
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Clean the paper path

During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product
has a cleaning mode that can correct and prevent these types of problems.

Specks Smearing

Clean the paper path from the product control panel

1. Press the Setup  button.  

2. Use the arrow buttons to select the Service
menu, and then press the OK button.

 

3. Use the arrow buttons to select the Cleaning
Page item, and then press the OK button.

 

4. Load plain letter or A4 paper when you are
prompted.

 

5. Press the OK button again to confirm and
begin the cleaning process.

A page feeds through the product slowly.
Discard the page when the process is
completed.

 

Clean the exterior

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the device.

Product updates
Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/LJColorMFPM175. Click Downloads and drivers, click the operating system,
and then select the download for the product.
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13 Solve problems

● Self help

● Solve problems checklist

● Factors that affect product performance

● Restore factory settings

● Interpret control panel messages

● Paper feeds incorrectly or becomes jammed

● Improve print quality

● The product does not print or it prints slowly

● Solve connectivity problems

● Solve wireless network problems

● Product software problems with Windows

● Solve common Mac problems
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Self help
In addition to the information in this guide, other sources are available that provide helpful
information.

HP Help and Learn Center The HP Help and Learn Center and other documentation are on the CD that came
with the product or in the HP Program folder on your computer. The HP Help and
Learn Center is a product help tool that provides easy access to product
information, HP product Web support, troubleshooting, and regulatory and safety
information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/support/LJColorMFPM175

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection (network models only)

● Step 3: Check the control panel for error messages

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Test copy functionality

● Step 8: Check the supplies

● Step 9: Try sending a print job from a computer

Step 1: Make sure that the product is set up correctly

Make sure that the product is set up correctly.

1. Press the power button to turn on the product or to deactivate the Auto-Off mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label that
is inside the product front cover for voltage requirements.) If you are using a power strip and its
voltage is not within specifications, plug the product directly into the wall. If it is already plugged
into the wall, try a different outlet.

4. Make sure that the print cartridge is installed correctly.

5. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection (network models only)

1. Check the cable connection between the product and the computer. Make sure that the
connection is secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.
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Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product.

Step 6: Test print functionality

1. Print a configuration page.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Test copy functionality

1. Place the configuration page into the document feeder and make a copy. If paper does not feed
smoothly through the document feeder, you might need to clean the document feeder. Also,
verify that the paper meets HP specifications.

2. Place the configuration page onto the scanner glass and make a copy.

3. If the print quality on the copied pages is not acceptable, clean the scanner glass.

Step 8: Check the supplies

Print a supplies status page and check remaining life of the print cartridges and imaging drum.

Step 9: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall
the software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the media that you
are using.
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Factors that affect product performance
Several factors affect the time it takes to print a job:

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Print quality settings in the printer driver.

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● The product I/O configuration

Restore factory settings
Restoring the factory-set defaults returns most of the settings to the factory defaults. It will not reset
the page count or tray size, but it might reset the language. To restore the product to the factory-
default settings, follow these steps.

1. On the product control panel, press the Setup  button.

2. Use the arrows buttons to select the Service menu, and then press the OK button.

3. Use the arrows buttons to select the Restore Defaults item, and then press the OK button.

The product automatically restarts.
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Interpret control panel messages
The majority of the control-panel messages are intended to guide the user through typical operation.
The control-panel messages indicate the status of the current operation, and include a page count on
the second line of the display, if appropriate. When the product is receiving print data or scanning
commands, control-panel messages indicate this status. In addition, alert messages, warning
messages, and critical error messages indicate situations that might require some action.

Control panel message types

Alert and warning messages appear temporarily and might require you to acknowledge the message
by pressing the OK button to resume or by pressing the Cancel  button to cancel the job. With
certain warnings, the job might not complete or the print quality might be affected. If the alert or
warning message is related to printing and the auto-continue feature is on, the product will attempt to
resume the printing job after the warning has appeared for 10 seconds without acknowledgement.

Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

NOTE: Supplies status messages are listed and described in the “Print cartridges and imaging
drum” chapter of this document.

Control panel messages

Control panel message Description Recommended action

49 Error

Turn off then on

The product has experienced a firmware
error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

50.X Fuser Error

Turn off then on

The product has experienced an internal
hardware error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 10 minutes, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.
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Control panel message Description Recommended action

52 Scanner Error

Turn off then on

The product has experienced a scanner
error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

79 Error

Turn off then on

The product has experienced a firmware
error

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

ADF door is open The document feeder door is open. Close the document feeder door.

Device error

Press [OK] to continue

The product experienced an internal
communication error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Doc. feeder jam The product has experienced a document
feeder jam.

Clear the document feeder jam.
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Control panel message Description Recommended action

Engine comm. Error The product has experienced an internal
hardware error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Jam in <location>

alternates with

Open door and clear jam

The product has detected a jam in the
location indicated in the message.

Clear the jam from the area indicated in the
message, and then follow the control-panel
instructions. Clearing some jams requires
you to open the print cartridge door and
remove the print cartridges.

Jam in output bin The product has detected a paper jam in the
output bin area.

Clear the jam from the area indicated in the
message, and then follow the control panel
instructions.

Jam in print paper path The product has detected a paper path jam. Clear the jam from the area indicated in the
message, and then follow the control panel
instructions.

Jam in Tray 1 The product has detected a jam in the input
tray.

Clear the jam from the area indicated in the
message, and then follow the control panel
instructions.

Load tray 1 <TYPE>, <SIZE> The tray is empty. Load the tray with the correct type and size
of paper.

Load tray 1 PLAIN <SIZE>

alternates with

Cleaning Page [OK] to start

The product is performing a cleaning cycle. Load the tray with plain paper of the size
indicated. Press the OK button to start the
cleaning cycle.

Manual duplex

alternates with

Load tray 1

Press [OK]

The product is processing a manual duplex
job.

To print the second side, place the pages
face down in the tray with the top edge first.

Manual feed <SIZE>, <TYPE>

alternates with

Press [OK] for available media

The product is set for the manual feed
mode.

Load the tray with the correct size and type
of paper, or press the OK button to use the
paper that is in the tray.
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Control panel message Description Recommended action

Memory is low

Press [OK]

The product does not have enough memory
to process the job.

If the product is processing other jobs, send
the job again after those jobs have finished.

If the problem continues, turn off the power
by using the power switch, and then wait at
least 30 seconds. Turn on the power and
wait for the product to initialize.

Break the job into smaller jobs that contain
fewer pages.

Resend the print job in raster mode.

Set the “Print Data Optimization” setting in
the print driver to “Optimize for Raster”.

Memory is low. Only 1 copy made.

Press [OK] to continue

Product memory is too low to complete this
job.

Either copy fewer pages at a time or turn off
collation.

If the error persists, turn the product off, and
then on.

Misprint

Press [OK]

The product has experienced an internal
hardware error.

1. Reprint the pages.

2. If the error persists, turn the product
off, and then on.

3. Print the pages again.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

No paper pickup

Press [OK]

The product has experienced an internal
hardware error.

1. Verify that the media was inserted far
enough into the input tray.

2. Load the tray with the correct size of
paper for your job.

3. Make sure the paper guides in the tray
are adjusted correctly for the size of
paper. Adjust the guides so they are
touching the paper stack without
bending it.

4. Check the product control panel to see
if the product is waiting for you to
acknowledge a prompt to feed the
paper manually. Load paper, and
continue.

5. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.
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Control panel message Description Recommended action

Print failure The product experienced an internal
communication error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Printing...

Cool-down mode

The product is too hot to continue printing at
normal speed.

The product will pause longer between
printed pages until it cools down.

Overheating occurs when the product lacks
air ventilation or when it prints continuously
for a long period of time. To prevent
overheating, place the product in a well-
ventilated area, and divide very large print
jobs into smaller print jobs.

Remove shipping material from rear door Shipping material remains on the back of
the product.

Open the rear door and remove all shipping
material.

Resend Upgrade A firmware upgrade was interrupted. Resend the upgrade file to the product.

Scanner Error X The product experienced a general scanner
error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Sensor Error The product experienced a paper sensor
error.

1. Turn off the power by using the power
switch.

2. If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3. Wait at least 30 seconds, and then turn
on the power and wait for the product
to initialize.

4. If the error persists, contact HP. See
www.hp.com/support/
LJColorMFPM175 or the support flyer
that came in the product box.

Settings cleared The product has cleared job settings. Re-enter any appropriate job settings.
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Control panel message Description Recommended action

Turn off. Reinstall fuser The fuser needs to be replaced. Turn off the power by using the power
switch.

Wait at least 30 seconds, and then turn on
the power and wait for the product to
initialize.

If the error persists, contact HP. See
www.hp.com/support/LJColorMFPM175 or
the support flyer that came in the product
box.

Unexpected Size in Tray 1 The paper in the tray does not match the
size needed for the current print job.

Load paper that is the correct size, and
verify that the tray is set to the correct size.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams

When clearing jams, be very careful not to tear jammed paper. If a small piece of paper remains in
the product, it could cause additional jams.

NOTE: After removing the jammed paper, open and close a product door to clear the control panel
jam message.

Jam locations

Jams can occur in these locations:

1
2

4

3

1 Document feeder

2 Output bin

3 Rear door

4 Input tray

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.
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Clear jams from the document feeder

1. Open the document feeder cover.  

2. Lift the document feeder mechanism, and
gently pull the jammed paper out.

 

3. Close the document feeder cover.  
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Clear jams from the input tray

1. Remove the paper from the input tray.  

2. With both hands, grasp the paper, and
carefully pull it free from the product.

 

3. Open and close the print cartridge door to
reset the product.

 

ENWW Paper feeds incorrectly or becomes jammed 151



Clear jams from the output bin

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.

1. With both hands, grasp the paper, and
carefully pull it free from the product.

 

Clear jams from the rear door

1. Open the rear door.  
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2. With both hands, grasp the paper, and
carefully pull it free from the product.

 

3. Close the rear door.  
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align the colors

● Use the printer driver that best meets your printing needs

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, click the More... option.

5. Expand the list of Type is options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.
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Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.
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4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option
to print color documents for photocopying or faxing.

6. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for
use in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of
the following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. On the product control panel, press the Setup  button.

2. Use the arrow buttons to select the Service menu, and then press the OK button.

3. Use the arrow buttons to select the Cleaning Page item, and then press the OK button.

4. Load plain letter or A4 paper when you are prompted.

5. Press the OK button to begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.

Calibrate the product to align the colors

If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might
need to calibrate the product to align the colors. Print the Diagnostics Page from the Reports menu
on the control panel to check the color alignment. If the blocks of color on that page are not aligned
with each other, you need to calibrate the product.

1. On the product control panel, open the System Setup menu.

2. Open the Print Quality menu, and select the Calibrate Color item.

3. Select the Calibrate Now option.

Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless
you select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5
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HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for
postscript flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single
driver for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

Download additional printer drivers from this Web site: www.hp.com/support/LJColorMFPM175.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn off the product and
disconnect the power cable from the product. Wait 30 seconds, and then reconnect the
power cord and turn on the product. Wait for the product to initialize.

◦ If the control panel indicates the product is ready, print a configuration page. If successful,
try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

6. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/LJColorMFPM175.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. When you configure the product to print at a high level of print quality, the product prints more
slowly. Change the print quality settings to change the print speed.

4. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

5. The product might be in cool-down mode. Wait for the product to cool.
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Solve connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP
address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you
change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if
necessary.

2. Reconfigure the network settings if necessary.

ENWW Solve connectivity problems 161



Solve wireless network problems

Wireless connectivity checklist

● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure
that the wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the
SSID. If you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless
network. If the network has Internet access, try connecting to the Internet over a wireless
connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the
wireless access point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the
product must be within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between
the access point and the product. Make sure poles, walls, or support columns containing metal
or concrete do not separate the product and wireless access point.

● Verify that the product is located away from electronic devices that might interfere with the
wireless signal. Many devices can interfere with the wireless signal including motors, cordless
phones, security system cameras, other wireless networks, and some Bluetooth devices.

● Verify that the printer driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and product connect to the same wireless network.

The product does not print after the wireless configuration completes

1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.
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The product does not print, and the computer has a third-party firewall
installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable
the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or
product

Make sure that the router or product connects to the same network that your computer connects to.

1. Print a configuration page.

2. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for the computer.

3. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block
the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access
point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.
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3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the router IP address.

For Mac, open the Network Utility, and then supply the IP address in the correct field in the
Ping pane.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects
to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the
printer configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.
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Product software problems with Windows

Problem Solution

A printer driver for the product is not visible in the
Printer folder

● Restart the computer to restart the spooler process. If the spooler
has crashed, no printer drivers will appear in the Printers folder.

● Reinstall the product software.

NOTE: Close any software programs that are running. To close a
software program that has an icon in the system tray, right-click the
icon, and then select the Close or Disable option.

● Try plugging the USB cable into a different USB port on the
computer.

An error message was displayed during the
software installation

● Reinstall the product software.

NOTE: Close any software programs that are running. To close a
software program that has an icon in the task bar, right-click the
icon, and then select the Close or Disable option.

● Check the amount of free space on the drive where you are
installing the product software. If necessary, free up as much space
as you can, and reinstall the product software.

● If necessary, run the Disk Defragmenter, and then reinstall the
product software.

The product is in Ready mode, but nothing prints ● Print a configuration page, and verify the product functionality.

● Restart the computer from which you are trying to print.

● Verify that all of the cables are correctly seated and within
specifications. This includes the USB and power cables. Try a new
cable.

● If trying to connect through a wireless connection, make sure that
the network cable is not connected.
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Solve common Mac problems
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print & Fax
list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in
the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.

A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.
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When connected with a USB cable, the product does not appear in the
Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain.
Disconnect all of the devices from the chain, and connect the cable directly to the USB port on
the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic
printer driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

HP original print cartridge, imaging drum, and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers
The following list of accessories was current at the time of printing. Ordering information and
availability of the accessories might change during the life of the product.

Print cartridges

Item Cartridge number Color Part number

HP LaserJet print cartridge 126A Black CE310A

Cyan CE311A

Yellow CE312A

Magenta CE313A

Imaging drums

Item Description Part number

Imaging drum Imaging drum CE314A

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on the supplies status page. HP's Premium Protection Warranty applies only
to the print cartridges for the product.

Cables and interfaces

Item Description Part number

USB 2.0 printer cable (2-meter standard) A-to-B cable C6518A
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B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● HP's LaserJet imaging drum limited warranty statement for replacement imaging drums

● Data stored on the print cartridge and imaging drum

● End User License Agreement

● OpenSSL

● Customer support

● Repack the product
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Pro 100 color MFP M175a, M175nw One-year product exchange

Imaging drum, CE314A, ships with product One-year product exchange

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from
defects in materials and workmanship after the date of purchase, for the period specified above. If HP
receives notice of such defects during the warranty period, HP will, at its option, either repair or
replace products which prove to be defective. Replacement products may be either new or equivalent
in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will
be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
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TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description
of the problem and print samples) or contact HP customer support. At HP's option, HP will either
replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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HP's LaserJet imaging drum limited warranty statement
for replacement imaging drums

This HP Product is warranted to be free from defects in materials and workmanship for one-year from
installation. This warranty does not apply to imaging drums that (a) have been refurbished,
remanufactured or tampered with in any way, (b) experience problems resulting from misuse,
improper storage, or operation outside of the published environmental specifications for the printer
product or (c) exhibit wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description
of the problem, print samples, and a copy of the configuration and supplies status page) or contact
HP customer support. At HP’s option, HP will either replace products that prove to be defective or
refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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Data stored on the print cartridge and imaging drum
The HP print cartridges and imaging drum used with this product contain a memory chip that assists
in the operation of the product.

In addition, this memory chip collects a limited set of information about the usage of the product,
which might include the following: the date when the print cartridge and imaging drum was first
installed, the date when the print cartridge and imaging drum was last used, the number of pages
printed using the print cartridge and imaging drum, the page coverage, the printing modes used, any
printing errors that might have occurred, and the product model. This information helps HP design
future products to meet our customers' printing needs.

The data collected from the print cartridge and imaging drum memory chip does not contain
information that can be used to identify a customer or user of the print cartridge and imaging drum or
their product.

HP collects a sampling of the memory chips from print cartridges and imaging drums returned to HP's
free return and recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips
from this sampling are read and studied in order to improve future HP products. HP partners who
assist in recycling this print cartridge and imaging drum might have access to this data, as well.

Any third party possessing the print cartridge and imaging drum might have access to the anonymous
information on the memory chip. If you prefer to not allow access to this information, you can render
the chip inoperable. However, after you render the memory chip inoperable, the memory chip cannot
be used in an HP product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User
License Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you
represent) and (b) Hewlett-Packard Company (“HP”) that governs your use of the software product
(“Software”). This EULA does not apply if there is a separate license agreement between you and HP
or its suppliers for the Software, including a license agreement in online documentation. The term
“Software” may include (i) associated media, (ii) a user guide and other printed materials, and (iii)
“online” or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING,
OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU
DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA,
PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN
DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR
MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third
Party Licenses include licenses that provide for the availability of source code (such as the GNU
General Public License) and the corresponding source code is not included with the Software, then
check the product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is
provided by HP for Use with an imaging or printing product (for example, if the Software is a printer
driver, firmware, or add-on), the HP Software may only be used with such product (“HP Product”).
Additional restrictions on Use may appear in the User Documentation. You may not separate
component parts of the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for
back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no
longer use such HP Software. This EULA applies to each Upgrade unless HP provides other terms
with the Upgrade. In case of a conflict between this EULA and such other terms, the other terms will
prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be
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an indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the
transferred Software will agree to this EULA. Upon transfer of the HP Software, your license is
automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer the
HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation
are owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to
the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS
ESSENTIAL PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with
FAR 12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation,
and Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.

Rev. 11/06

178 Appendix B   Service and support ENWW



OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase,
and problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/LJColorMFPM175

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/support/LJColorMFPM175

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Repack the product
If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain the print cartridges.

CAUTION: It is extremely important to remove the print cartridges before shipping the product.
A print cartridge that remains in the product during shipping can leak and cover the product
engine and other parts with toner.

To prevent damage to the print cartridges, avoid touching the rollers on them, and store the print
cartridges so that they are not exposed to light.

2. Remove and retain the power cable, interface cable, and any optional accessories.

3. If possible, include print samples and 50 to 100 sheets of paper that did not print correctly.

4. In the U.S., call HP Customer Care to request new packing material. In other areas, use the
original packing material, if possible.
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C Specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Physical specifications1

Specification HP LaserJet Pro 100 color MFP M175

Product weight 15.8 kg (34.8 lb)

Product height 337 mm (13.3 in)

Product depth 323 mm (12.7 in)

Product width 442 mm (17.4 in)

1 Values are based on preliminary data. See www.hp.com/support/LJColorMFPM175.

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/support/LJColorMFPM175 for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications
Table C-2  Environmental specifications

 Operating1 Storage1

Temperature 10° to 32.5°C (50° to 91°F) 0° to 35°C (32° to 95°F)

Relative Humidity 10% to 80% 10% to 80%

1 Values are based on preliminary data. See www.hp.com/support/LJColorMFPM175.
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity (base models)

● Declaration of conformity (wireless models)

● Safety statements

● Additional statements for wireless products
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy. If this equipment is not installed and used in accordance with the
instructions, it may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could
void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production

This product generates no appreciable ozone gas (O3).

Power consumption

Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. Hewlett-Packard printing and
imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental
Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Paper use

This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on
one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are
recycled properly, processing them to recover plastics and metals for new products and diverting
millions of tons of waste from landfills. Since this cartridge is being recycled and used in new
materials, it will not be returned to you. Thank you for being environmentally responsible!
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NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use
this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or
more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For US and Puerto Rico HP LaserJet print cartridge recycling returns, use the pre-paid, pre-
addressed shipping label contained in the box. To use the UPS label, give the package to the UPS
driver during your next delivery or pick-up, or take it to an authorized UPS drop-off center.
(Requested UPS Ground pickup will be charged normal pick-up rates) For the location of your local
UPS drop-off center, call 1-800-PICKUPS or visit www.ups.com.

If you are returning the package with the FedEx label, give the package to either the U.S. Postal
Service carrier or FedEx driver during your next pick-up or delivery. (Requested FedEx Ground
pickup will be charged normal pick-up rates). Or, you can drop off your packaged print cartridge(s) at
any U.S. Post Office or any FedEx shipping center or store. For the location of your nearest U.S. Post
Office, please call 1-800-ASK-USPS or visit www.usps.com. For the location of your nearest FedEx
shipping center/store, please call 1-800-GOFEDEX or visit www.fedex.com.

For more information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle
or call 1-800-340-2445. Information subject to change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.
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Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of
with your other household waste. Instead, it is your responsibility to dispose of your waste equipment
by handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human
health and the environment. For more information about where you can drop off your waste
equipment for recycling, please contact your local city office, your household waste disposal service
or the shop where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example,
toner) can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/
hpinfo/community/environment/productinfo/safety.

For more information

To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system
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● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity (base models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1001-02-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Pro 100 color MFP M175a

Regulatory Model Number2) BOISB-1001-02

Product Options: ALL

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11

IEC 60825-1:2006 / EN 60825-1:2007 Class 1 Laser/LED Product)

IEC 62311:2007 / EN 62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

ENERGY USE: Regulation (EC) No. 1275/2008

ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test
Procedure

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the

EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho USA

October 2010

For regulatory topics only:
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European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX:
+49-7031-14-3143) www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Declaration of conformity (wireless models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#:BOISB-1001-03-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Pro 100 color MFP M175nw

Regulatory Model Number2) BOISB-1001-03

Product Options: ALL

Radio Module3) SDGOB – 0892

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006 +A11

IEC 60825-1:2006 / EN 60825-1:2007 Class 1 Laser/LED Product)

IEC 62311:2007 / EN 62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Radio5) EN 301 489-1:V1.8.1 / EN 301 489-17:V1.3.2

EN 300 328: V1.7.1

FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

ENERGY USE: Regulation (EC) No. 1275/2008

ENERGY STAR® Qualified Imaging Equipment Typical Electricity Consumption (TEC) Test
Procedure

Supplementary Information:

The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex IV, EMC Directive 2004/108/EC and the

Low Voltage Directive 2006/95/EC, the EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatory
requirements for the countries/regions this product will be sold.

Boise, Idaho USA

October 2010

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX:
+49-7031-14-3143) www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration
has implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 110-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)

EMC statement (Korea)
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Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Pro 100 color M175a, M175nw, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1
laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Pro 100 color M175a, M175nw - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi
huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita
käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m
W Luokan 3B laser.

GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.
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Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Additional statements for wireless products

FCC compliance statement—United States

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human
proximity to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of
this product without the express approval by Hewlett-Packard Company may invalidate its authorized
use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio
transmission exposure, it is recommended that this device be operated no less than 20 cm from the
head, neck, or body.

Brazil ANATEL statement

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a
sistemas operando em caráter primário.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Canadian Department of
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriques
dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le
règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.
Le composant RF interne est conforme à la norme CNR-210 d´Industrie Canada.

European Union regulatory notice

The telecommunications functionality of this product may be used in the following EU and EFTA
countries/regions:

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.
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Notice for use in France

For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be
used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only
2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see
www.arcep.fr.

L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cet
équipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de
2400-2483.5 MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser
les fréquences comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir,
www.arcep.fr.

Notice for use in Russia

Существуют определенные ограничения по использованию беспроводных сетей (стандарта
802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри
помещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При
использовании внутри помещений максимальная эффективная изотропно–излучаемая
мощность (ЭИИМ) должна составлять не более 100мВт.

Korean statement

Taiwan statement
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Symbols/Numerics
2-sided printing

Windows 84

A
accessories

ordering 169, 170
part numbers 170

acoustic specifications 182
ad-hoc wireless network

configuring 44
description 43

altitude specifications 182
anticounterfeit supplies 68

B
batteries included 187
bins, output

jams, clearing 152
black and white scanning 125
booklets

printing (Windows) 99

C
Canadian DOC regulations 193
canceling

copy jobs 111
print job 29, 78
scan jobs 123

cartridges
non-HP 68
part numbers 170
recycling 67, 185
storage 67
supplies status page 128
warranty 174

cartridges, print
Macintosh status 32

cautions iii

cleaning
exterior 136
glass 114, 126
paper path 136, 157
printer 135

collating copies 112
color

adjusting 102
Edge Control 103
halftone options 104
manage 101
matching 106
Neutral Grays 104
printed vs. monitor 106
using 101

color alignment, calibrating 157
color options

HP EasyColor (Windows) 105
setting (Windows) 90

color settings
adjusting 155

Color tab settings 31
color usage log 128
color, scanning settings 124, 125
configuration page 128
connecting to a wireless

network 40
connecting to the network 39
connectivity

solving problems 160
USB 38

contrast settings
copy 115

control panel
cleaning page, printing 136
menu map, printing 128
menus 8
message types 142

messages,
troubleshooting 142

settings 26
conventions, document iii
copies

changing number of
(Windows) 80

copying
canceling 111
collation 112
contrast, adjusting 115
Copy Menu 12
double-sided 119
edge-to-edge 115
enlarging 111
light/dark settings 115
multiple copies 108
one-touch 108
paper settings 116
photos 117
quality, adjusting 113
reducing 111
restore default settings 116

counterfeit supplies 68
cover pages

printing (Mac) 30
custom print settings

(Windows) 80
custom-size copies 111
custom-size paper settings

Macintosh 29
customer support

online 179
repacking product 180

D
darkness, contrast settings

copy 115
declaration of

conformity 189, 191
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default settings, restore 141
defects, repeating 71
demo page 128
device status

Macintosh Services tab 32
disposal, end-of-life 187
document conventions iii
document feeder

jams 150
double-sided printing

paper loading orientation 56
dpi (dots per inch)

scanning 124
drivers

changing paper types and
sizes 50

changing settings (Mac) 27
changing settings

(Windows) 19
presets (Mac) 29
settings (Mac) 29
settings (Windows) 79
usage page 128

drum
warranty 175

duplex printing
paper loading orientation 56
Windows 84

E
e-mail, scanning to

resolution settings 125
Edge Control 103
edge-to-edge printing 115
electrical specifications 182
end-of-life disposal 187
enlarging documents

copying 111
envelopes

loading orientation 56
environment specifications 182
environmental features 3
environmental stewardship

program 185
error messages

control panel 142
errors

software 165
European Union, waste

disposal 187

F
Finnish laser safety

statement 194
firewall 40
first page

use different paper 30
fonts

lists, printing 128
forms

printing (Windows) 92
fraud hotline 68

G
glass, cleaning 114, 126
grayscale printing, Windows 91
grayscale scanning 125

H
help

printing options (Windows) 79
HP Customer Care 179
HP Easy Color

disabling 105
using 105

HP fraud hotline 68
HP Scan (Windows) 122
HP Utility 28
HP Utility, Mac 28
HP Web Jetadmin 20, 131
HP-UX software 21
humidity specifications 182

I
identification cards

copying 110
imaging drum

checking for damage 70
memory chips 176
storage 67
warranty 175

imaging drum, part number 170
infrastructure wireless network

description 43
input tray

capacity 56
loading 55

installing
software, USB connections 38
software, wired

networks 25, 40

IP address
automatic configuration 25, 40
manual configuration 25, 39

J
jams

causes of 148
document feeder,

clearing 150
locating 149
output bin, clearing 152
rear door, clearing 152
tracking number of 128
trays, clearing 151

Japanese VCCI statement 193
Jetadmin, HP Web 20, 131

K
Korean EMC statement 193

L
labels

printing (Windows) 94
landscape orientation

changing (Windows) 88
laser safety statements 193, 194
letterhead

printing (Windows) 92
license, software 177
lightness

copy contrast 115
Linux 21
Linux software 21
loading media

input tray 55
lock

product 132
low power settings

disabling 133
enabling 133

M
Mac

changing paper types and
sizes 29

driver settings 27, 29
HP Utility 28
installing software 24
problems, troubleshooting 34
removing software 26
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scanning from TWAIN-
compliant software 122

supported operating
systems 24

Macintosh
resize documents 29
support 179

Macintosh driver settings
custom-size paper 29
Services tab 32
watermarks 30

managing network 45
matching colors 106
material restrictions 187
Material Safety Data Sheet

(MSDS) 187
media

custom-size, Macintosh
settings 29

first page 30
pages per sheet 31
supported sizes 51

media jams. See jams
memory chip, imaging drum

description 176
memory chip, print cartridge

description 176
menu

Copy Menu 12
Network Setup 11
Reports 8
Service 10
System Setup 8

menus, control panel
map, printing 128

mercury-free product 187
messages

control panel 142
model number 5
multiple pages per sheet

printing (Windows) 86

N
n-up printing

selecting (Windows) 86
network

configuring 11
disabling wireless 41
IP address

configuration 25, 39

operating systems
supported 36

settings, changing 45
settings, viewing 45

network connections 39
Network Setup menu 11
networks

configuration page 128
HP Web Jetadmin 131
settings report 128

Neutral Grays 104
non-HP supplies 68
notes iii
number of copies, changing 108

O
OCR software 123
online support 179
opening printer drivers

(Windows) 79
operating environment

specifications 182
operating systems supported 24
operating systems Windows,

supported 16
operating systems, networks 36
optical character recognition

software 123
ordering

part numbers for 170
supplies and accessories 170

ordering supplies
Web sites 169

orientation
changing (Windows) 88
paper, while loading 56

P
packaging product 180
page count 128
page orientation

changing (Windows) 88
page sizes

scaling documents to fit
(Windows) 97

pages per sheet
selecting (Windows) 86

paper
copy settings 116

custom-size, Macintosh
settings 29

first page 30
jams 148
loading orientation 56
pages per sheet 31
printing on preprinted

letterhead or forms
(Windows) 92

selecting 156
supported sizes 51

paper jams. See jams
paper pickup problems

solving 148
paper size

changing 50
paper sizes

selecting 83
selecting custom 84

paper type
changing 154

paper types
changing 50
selecting 84

paper, covers
printing (Windows) 96

paper, ordering 170
paper, special

printing (Windows) 94
part numbers

print cartridges 170
PCL font list 128
photos

copying 117
physical specifications 182
pixels per inch (ppi), scanning

resolution 124
portrait orientation

changing (Windows) 88
power

consumption 182
ppi (pixels per inch), scanning

resolution 124
preprinted paper

printing (Windows) 92
presets (Mac) 29
print cartridges

Macintosh status 32
memory chips 176
non-HP 68
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part numbers 170
recycling 67, 185
storage 67
supplies status page 128
warranty 174

print job
canceling 29, 78
changing settings 18

print media
supported 51

print quality
improving 154
improving (Windows) 83

print tasks 77
printer

cleaning 135
printer driver

configuring wireless
network 41

printer drivers
choosing 157

printer drivers (Mac)
changing settings 27
settings 29

printer drivers (Windows)
changing settings 18, 19
settings 79

printing
edge-to-edge 115
Macintosh 29
settings (Mac) 29
settings (Windows) 79

priority, settings 26
problem-solving

control-panel messages 142
no response 159
slow response 159

product
software for Windows 15
view 4

PS font list 128

Q
quality

copy settings 113
print settings (Macintosh) 29

R
Readiris OCR software 123

rear door
jams 152

recycling
HP printing supplies returns

and environmental
program 186

recycling supplies 67
reducing documents

copying 111
removing Mac software 26
repacking product 180
repeating defects,

troubleshooting 71
repetetive defects,

troubleshooting 71
reports

color usage log 8
configuration page 8
demo page 8
diagnostics page 8
menu map 8
network summary 8
PCL 6 font list 8
PCL font list 8
print quality page 8
PS font list 8
service page 8
supplies status page 8
usage page 8

resize documents
Macintosh 29
Windows 97

resizing documents
copying 111

resolution
scanning 124

S
safety statements 193, 194
scale documents

Macintosh 29
Windows 97

scaling documents
copying 111

scanner
glass cleaning 114, 126

scanning
black and white 125
canceling 123
color 124

from HP Scan (Windows) 122
from Mac software 33
grayscale 125
methods 122
OCR software 123
resolution 124
TWAIN-compliant

software 122
WIA-compliant software 122

serial number 5
service

repacking product 180
Service menu 10
service page 128
Services tab

Macintosh 32
settings

driver presets (Mac) 29
drivers 19
drivers (Mac) 27
network report 128
priority 26

shipping product 180
shortcuts (Windows)

creating 81
using 80

size specifications, product 182
size, copy

reducing or enlarging 111
sleep delay

disabling 133
enabling 133

small documents
copying 110

software
HP Utility 28
HP Web Jetadmin 20
installing, USB

connections 38
installing, wired

networks 25, 40
Linux 21
problems 165
Readiris OCR 123
scanning from TWAIN or

WIA 122
settings 26
software license

agreement 177
Solaris 21
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supported operating
systems 24

supported Windows operating
systems 16

uninstalling for Windows 20
uninstalling Mac 26
UNIX 21
Windows 20

Solaris software 21
solving

direct-connect problems 160
network problems 160

special media
guidelines 48

special paper
guidelines 48
printing (Windows) 94

special paper for covers
printing (Windows) 96

specifications
electrical and acoustic 182
environment 182
physical 182

status
HP Utility, Mac 28
Macintosh services tab 32
supplies, printing report 128

storing
print cartridges 67
product 182

supplies
counterfeit 68
non-HP 68
ordering 169, 170
part numbers 170
recycling 67, 185
status, viewing with HP

Utility 28
supplies status page

printing 71
supply-status, Services tab

Macintosh 32
support

online 179
repacking product 180

supported media 51
System Setup menu 8

T
TCP/IP

operating systems
supported 36

technical support
online 179
repacking product 180

temperature specifications 182
tips iii
toner cartridges. See print

cartridges
transparencies

printing (Windows) 94
trapping 103
trays

capacity 56
jams, clearing 151
paper orientation 56

troubleshooting
checklist 139
control panel messages 142
direct-connect problems 160
jams 148
Mac problems 34
network problems 160
paper feed problems 148
repeating defects 71

TWAIN-compliant software,
scanning from 122

two-sided printing
Windows 84

U
uninstalling Mac software 26
uninstalling Windows software 20
UNIX 21
UNIX software 21
usage page 128
USB

configuring wireless
network 26, 41

USB cable, part number 170
USB configuration 38

V
view, product 4

W
warnings iii
warranty

imaging drum 175

license 177
print cartridges 174
product 172

watermarks
adding (Windows) 99

Web sites
customer support 179
fraud reports 68
HP Web Jetadmin,

downloading 131
Macintosh customer

support 179
Material Safety Data Sheet

(MSDS) 187
ordering supplies 169

WIA-compliant software, scanning
from 122

Windows
driver settings 19
scanning from TWAIN or WIA

software 122
software components 20

wireless
disabling 41

wireless network
ad-hoc 43
communication modes 43
configuring ad-hoc 44
configuring with USB 26, 41
configuring with WPS 26, 40
infrastructure 43
installing the driver 41
security 43

wireless network connection 40
wireless network interference 42
WPS

configuring wireless
network 26, 40
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